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Introduction
Purpose

The purpose of this document is to explain to you how to set up Bytescribe Development Company’s
Export Utility. Once the setup is complete, you will be able to automatically and/or manually convert
.vox format audio files from your Orator Digital Dictation System into .wav format files.

Assumptions & necessary equipment

This document assumes that you already have the following:
e An Orator Digital Dictation System from Bytescribe Development Co.
e A second computer (called the Management Computer in this document),
e A working network connection between the Orator and the Management Computer

e  Valid software licenses for Export Utility, including the proper password for the Export
Utility installation

Checking network connections

Before beginning, it is a good idea to check the network connections between your Orator and the
Management Computer. To do this:

1. Turn on both computers.

2. On the Management Computer, click on the Start button and select Run.
3. In the box that comes up, type \Orator.
4

After a few minutes, a Windows Explorer box should appear, displaying all of the available
folders on the Orator.

If the Windows Explorer window never shows up, please double check your network connections and
settings on both the Orator and the Management Computer. Once you are able to complete step #4
above successfully, you may continue with the instructions in this document.

Share and map drives
Share E: drive on Orator

If you have not already done so, you will need to share the E: drive on your Orator. To do this:
1. On the Orator, open Windows Explorer (you can do this by right-clicking on the My
Computer icon on the desktop and choosing Explore).

2. On the left-hand side of the Windows Explorer window, you should see an icon for My
Computer. Beneath that icon will be a list of the drives on your Orator. Right-click on the E:
drive and select Sharing . . ..

3. The Properties window for the E: drive should pop up. Click on the Sharing tab if it is not
already selected.
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4. At the top of the window will be two radio buttons (circles with a black dot in one of them).
Click to place the black dot in the circle labeled Share this folder, as in the picture below.
You should not need to make any additional changes.

Dictation {E:} Properties ﬂil

Generall Toolz | Hardware Sharing | Securit_'.JI Quotal

*Y'ou can share this folder among other users on pour
netwark. To enable sharing for this folder, click Share this

folder.

= Do not share this folder

Share name: IE j
LComment: I
Ulser limit: % Magirum allowed

£ Al = Users

To zet permissions for how users access this Ermilesins |
falder over the network., click Pemizsions. —

To configure gettings for Offine access to Eaaikin |
this shared folder, click Caching. g

Bemave Sharel Mew Share |

0K I Cancel | Apply |

5. Click Ok.

In the Windows Explorer window, you should see a small, blue hand appear under the icon for the E:
drive, as in the picture below. This means that the drive is now shared and can be seen and accessed

by other computers on the network.

& My Computer - 0] x|
Ele Edit Yiew Favorites Tools Help |
P Back + = - | @Search [+, Folders 8 | e O X @y | E~
Address IE.C_!'[ My Computer | @
Mame # | Type | Tokal Size | Free Space |
ﬁS‘f& Floppy (A1) 31-Inch Floppy Disk.
=Lacal Disk () Local Disk. 2,92 GB 105 MB
@Compact Disc (i) Compact Disc
g2 Dickation (E:) Local Disk 34.3GE 19,0 GB
(=] Control Panel System Folder
|5 object(s) | |@. Iy Computer 4

Map Orator’s E: drive on the Management Computer

Note: these instructions tell how to map a drive in Windows 2000. If you have a different version of
windows on your Management Computer, please check the Windows Help for instructions on how to

map a drive.
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Now that you have shared the E: drive on the Orator, you will need to “map” it to a drive letter on the
Management Computer so that Export Utility can access its files. To do this:

1. On the Management Computer, open Windows Explorer.

2. Click on the Tools menu, and select Map Network Drive . . .

3. The window that pops up will have two fields labeled Drive and Folder, and a check box
labeled Reconnect at logon. Click to place a check in this box.

4. In the field labeled Drive, choose the letter that you want to for the Orator’s drive. It can be

any of the letters that are listed there. For the purposes of this document, we will be using G:.

5. In the field marked Folder, type \\Orator\E, as

Map Network Drive

in the picture below.

]

Windows can help you connect ko a shared network Folder
and assign & drive letter to the connection so that vou can
access the Folder using My Computer.

Specify the drive letter For the connection and the Folder
that you want to connect to:

Drrive: IG: j
Folder: I'I,'I,Orator'l,E j Brawse. .. |

Example; Yiserverishare

v Reconnect at lngon

Connect using a different user narie.

Create a shorkout bo a Web Folder or FTP site,

Cancel |

< Back TR

6. Click Finish.

In the Windows Explorer window, you should now see another drive letter listed under My Computer.

It should be labeled E on ‘Orator’ and should have the
like this (G:), as in the picture below.

letter you chose in parentheses after the label,

™ My Computer -0l x|
File Edit Yiew Favorites Tools  Help ﬁ
qmEack ~ = - | Qhsearch  [yFolders &% | Pl rEdl o) | Ed-

Address IE.EJ, My Computer | @eo
Mame | Type | Tokal Size | Free Space |
é@‘f& Floppy (A:) 3t4-Inch Floppy Disk

=Lacal Disk () Local Disk 2.92 0GB 104 MB
@Compact Disc (D) Compact Disc

g Data(E:) Local Disk, 34.3GE 19.0GE

(=] Control Panel Swstem Folder

SPEon'Orator' (&) Metwork Drive 34,3 GB 19.0 GB

|6 object(s) |E.g]‘ My Computer i

Share and map drives
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Install and configure Export Utility
Get Export Utility installation file

The most recent version of the Export Utility installation file is Export452_ Setup.exe, which is
available for download at http://www.bytescribe.com/support/export.htm. A similar installation file
may be on your Orator. Regardless of where you get the file, you will need to download a copy of it
to the Management Computer.

Install Export Utility

Once you have a copy of the Export Utility installation file on the Management Computer, double-
click on it to run the installation program. You will need a password to install Export Utility, which
you can get by contacting Bytescribe Development Co. at 408-987-5628. After typing in the
password, continue with the installation. It is suggested that you leave all of the default installation
settings, which will place the Export Utility folders and files on the C: drive. If you must use a
different drive, please make note of it.

Change drive letter on Import Directories

Once installation is complete, you will need to change the drive letter for the Import Directories in
order for Export Utility to see the files on the Orator. To do this:

1. Start the Export Utility software.

2. Click on the View menu, and select Directories. The Directories window will pop up, as in
the picture below.

il
Input Directories Output Directories |ﬂ
c:\Dictation SystemiTypel o hconvertstsphtypel
c:\Dictation System'Type2 choonvertitsphtype2
o hDictation Spstem'Tpped choonverthephlyped
c:\Dictation System'Typed choonverthtsphtyped
o hDictation System' T ppeb choonverthephlypeh
c:\Dictation System'Typef c\convertstsphtypeb
c:\Dictation System'Type? choonvertitsphtype?
c:%Dictation System'sTyped c\convertstsphtyped
c:4Dictation System'Typed choonvertitzphtyped

[ |
Save LCloze |

3. On the left-hand side are the paths for the Input Directories, where the Export Utility will
look for .vox files to convert. Triple-click on the first directory path and highlight the drive
letter (it should be c).

4. Type in the drive letter that you mapped to E on Orator in the previous section. For example,
if you used G as the drive letter, your first directory path should read G:\Dictation
System\Typel.

5. Do this for all of the Input Directories. Leave the Output Directories alone. The windows
should look like the one in the picture below.
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=10
Input Directories Output Directories | -
g \Dictation SystemiTypel o hconvertstsphtypel
g SDictation System'Type2 choonvertitsphtype2
g:4Dictation System' T pped choonverthephlyped
g %Dictation System'Typed choonverthtsphtyped
g:4Dictation System'Tppeb choonverthephlypeh
g \Dictation System'Typel c\convertstsphtypeb
g \Dictation System'Type? choonvertitsphtype?
g “Dictation System'sTyped c\convertstsphtyped
g %Dictation System'Typed choonvertitzphtyped
[ |
Save LCloze |

6. Click Save.

7. You may be asked if you want to create each of the output directories. Click Yes for each
one.

Please note that Export Utility installs with 9 Input and Output Directories. If you plan to have more,
you will need to manually insert the paths. Also, Export Utility will only see and convert files in
folders for which you have entered the directories. So, for example, if you do not wish to have Export
Utility convert files in the type8 folder, simply delete the pathname for the type8 folder from the Input
Directories.

If your Orator already has dictation files on it, you should be able to see those files in the Export
Utility main window, as in the picture below.

Ik

Run  Yiew Help
|| &= o0

Yow File | Size (kB | wav File | Size (KB] | Irput Dir =
245 0205001 1234 0000 00 vox 71 g Dictati
[RIN 0823-001 4545 0000 00 vax 47 g Diictati
PRI O 03001 4545 0000 00 vox 47 g Diictati
FAI M 0103-002 4545 0000 00 vox 42 g Dictati
FEI M 003003 4545 0000 00 vax 50 g Dictati
FRIN 0103-004 4545 0000 00 vax 4 g Diictati
PRI O 03005 4545 0000 00 vox 48 g Diictati
PRI 0103-006 4545 0000 00 vox ] g Dictati
Rl M 003007 4545 0000 00 vax 51 gDictatic
PRI M O 03008 4545 0000 00 vox 49 g Dictati
ﬂ M O 3-009 4545 0000 00 v ] I a:\DicEiI\ﬂ

[Total Files: 12 [ |Format: PCM &8 kHz [ v

Setting up automatic conversions

You can set up Export Utility to automatically convert the files from the Orator. To do this:
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1. In the Export Utility, click on the View menu and select Options.

2. The Options window will pop up. In the section labeled Scheduled Conversion, click to place
a check mark in the box labeled Scheduled Timer On, as in the picture below.

-+-0ptions =1olx|
Input Waw Farrnat: IF'CM AkHz j

Output Format; ITrueSpeechWav 'l Cancel |
Output Gain: |+3 dB vl

Scheduled Conversion—————— |

W Scheduled Timer On

Timer Interval [minutes] 120 %

[~ Create Emar Log
[T Generate Underscores in Outpot File

[~ Append Type Directary to Dutput Filenarne

3. In the box labeled Timer Interval (minutes), type the number of minutes that you want Export
Utility to wait between each conversion. This will be the amount of time in minutes that
Export Utility will wait from the end of one conversion session to the beginning of the next
one.

4. Click OK.

Performing manual conversions

Instead of, or in addition to, automatic conversions, you may run manual conversions of the .vox files.
To do this:

1. In the Export Utility, click on the Run menu, and select Convert All Files.

This will run a conversion of all the new files in the Input Directories.

Install and configure DocShuttle Administrator

You are now ready to install DocShuttle Administrator on your computer. It is important that the files
for DocShuttle Administrator be placed in the proper folders on your computer, so that DocShuttle can
automatically see the converted files.

If you have not already installed DocShuttle Administrator, you may do so now. Follow the
installation wizard’s instructions and accept the defaults. DocShuttle Administrator will install itself
into the C:\Convert\tsp\ folder, which is where it needs to be to see the converted files.
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